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Why is it important to first find the right way to do something with a word 
processor? 
 
You will save time, make fewer errors and be more likely to keep your job. 
  
The goal of this class is to give you enough knowledge to do well with MS Word and to 
realize when you need to find instructions to learn to do new things the right way the first 
time. 
 
 

Credits: 
 
A lot of hard work went into this information and a lot of it is not mine.  Look here for 
more information. – James  
 
http://word.mvps.org/ 
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1) Tips 

Tips from http://www.faughnan.com/msword.html 
 

Avoid doing this in Word documents: 

Word 2003 Word 2007 
1. Do not adjust the default standard 

template Normal.dot standard 
template. Use new templates that 
you can have complete control 
instead. and use a different template 
for each document type. 

 

No difference 

2. Don’t use “Normal” style 
formatting.  This will often change. 
Create a new style for each new 
format instead.  You may use 
Word's built-in Heading Styles 
(which you can redefine to look the 
way you want) 

 

No difference 

3. Avoid Word's List Numbering 
which has more bugs than a 
compost heap. 

 

Improved with 2007 version 

Do these instead: 

Word 2003 Word 2007 
4. Turn off “Allow fast saves” (Tools 

/ Options / Save). 
Top left Office Button / Word Options / 
Save Link 
 

5. Do not use Master Documents, 
Versions, or the Document Map. 
Outline View is safe to use. 

 

Master Document was dropped from Word 
2007 

6. Select Tools / Options / 
AutoCorrect, and de-select most of 
the options. 

 

Top left Office Button / Word Options / 
Proofing Link 
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7. Tools / Options / Save: check 
prompt to save template. 
 

Fixed in Word 2007 

8. Tools: Templates and AddIns: 
Make sure "Automatically update 
document styles" is unchecked.  

 

Top left Office Button / Word Options / 
Advanced Link - Prompt to Update Style 
option 

9. Be wary of Section Breaks. Unless 
you are writing a report that needs 
them.  They can be very buggy to 
use. 

 

Hopefully a little better in Word 2007.  Use 
reveal all codes if you must work with 
Section Breaks, so you can see where you 
are. 

10. In Options:View set style width to 
1", this will let you quickly see 
what style applies to a paragraph. 

 

Styles are viewable in the top bar Home Tab 

11. In Options: Edit disable "click and 
type". 

 

Not applicable 

12. If you paste text and see odd things 
happen try: 

Paste as plain text - or 
Insert a section break first, then paste. 
Styles are bound up with section 
breaks, you can use them to keep things 
straight. 

 

Same 

13. Not applicable Consider changing default document type 
from docx to doc so people with older 
versions of MS Word can read your 
documents. 
Top left Office Button / Word Options / 
Save Link – Save Files in Format .doc 
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2) Layout changes in Word 2007 

 
 

 
 
 

 
 

 
 

 
 



Word Class #2 EU 04/01/12 Page 4  

  

 
 

 
 

 
 

 
 
Microsoft Word 2007 online courses: 
 
http://office.microsoft.com/en-us/word-help/CH010224760.aspx 
 
http://blogs.office.com/ 
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3) Reasons to try Office 2010 

Express your ideas more visually. 

Office 2010 opens up a world of design options to help you express your ideas with more 
impact. New and improved picture formatting tools, such as color saturation and artistic 
effects, let you transform your visuals into works of art. And a wide range of new 
customizable themes and SmartArt® graphic layouts offer more ways to make your ideas 
stick. 

 

Accomplish more when working together. 

Brainstorm ideas, keep versions in sync, and meet deadlines faster when you’re working 
in groups. Co-authoring in Word 2010, PowerPoint 2010, Excel Web App, and OneNote 
2010 shared notebooks enable you to edit the same file at the same time with other people 
— even when they’re in different locations.1 
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Enjoy the familiar Office experience from more locations and devices. 

With Office 2010, you can get things done on your schedule. 

• Microsoft Office Web Apps. Extend your Office 2010 experience to the Web. 
Store your Word, Excel, PowerPoint, and OneNote files online and then access, 
view, edit, and share content from virtually anywhere.2 

• Microsoft Office Mobile. Stay current and respond quickly using new mobile 
versions of Office applications designed specifically for your Windows Phone 7 
device.3 

• Microsoft SharePoint Workspace 2010. Synchronize SharePoint 2010 lists and 
libraries with SharePoint Workspace, formerly known as Microsoft Office 
Groove, so you can access, view, and edit files anytime and anywhere from your 
computer. Everything will automatically sync to the SharePoint server when 
you’re back online. 

Work your way, faster and more easily. 

Microsoft Office Backstage™ view replaces the traditional File menu to give you a 
centralized space for all of your file management tasks, including save, share, print, and 
publish. The enhanced Ribbon, common across Office 2010 applications, lets you access 
commands quickly and create or customize tabs to fit your work style. 

 
 
 
More Word 2010 training classes in Powerpoint at: 
 
http://office.microsoft.com/en-us/word-help/CH010369478.aspx 
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http://www.groovypost.com/customsearch/?cx=partner-pub-
0963256050141200%3Al2550hq1xnc&cof=FORID%3A11&ie=ISO-8859-
1&q=Word+2010&siteurl=www.groovypost.com%252Ftags%252Fmicrosoft-
office%252F&ref= 
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4) Format a document to any standard with many possible 

fonts - Word 2003  images – valid for all  Word versions 

View Normal or Outline? 
Word's Outline View is wonderful for long documents . 
 
In order to make use of it, you should create all your 
headings use Word's built-in Heading Styles (which 
you can redefine to look the way you want) – using 
Heading 1 for your Chapter headings, Heading 2 for 
subheadings and so on.  
 
• Outline View lets you view all your Headings 

collapsed to any heading level you want. 
• Click on a Heading 1 paragraph, and then click on 

the + button to expand. 
• Restructure your document.  
• Drag and drop a heading  
 
 

Search Replace Ctrl +H 
Where this can be especially useful is in the Replace dialog. Suppose you want to search 
for bold text and remove the bold formatting only if it is direct formatting, not defined by 
the style. If you press Ctrl+B in the “Find what” box, you’ll get Format: Bold. If you 
press Ctrl+B twice in the “Replace with” box, you’ll get Format: Not Bold. This 
combination will find bold text and remove the bold formatting, but it will remove it from 
all the bold text, even the headings that are supposed to be bold. But if you search for 
Format: Bold and replace with Default Paragraph Font, you will remove only the direct 
formatting, leaving the bold styles alone. (To select the Default Paragraph Font in the 
Replace dialog, click More (if necessary) to expand the dialog, then click Format, select 
Style, and then click on Default Paragraph Font.) 
 
Incidentally, you might think that Ctrl+Spacebar would work the same here as in a 
document; unfortunately, it does not (though it is a shortcut for clearing formatting from 
the “Find what” box before you run the next Replace operation). 
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Setting Tabs 
By default, a Word document has built-in tab stops at half-inch intervals. You can change 
the default spacing in a given document using the spin box in the top right corner of the 
Format | Tabs dialog, but in general it is preferable to avoid using the built-in tab stops at 
all. 
 
Have you ever tried pasting from someone else's documents into your own, or even just 
changing the page margins, or the font; and found that their tabbed lists no longer line 
up—so you have to waste a lot of time reformatting them? If so, it's because the person 
who created the document didn't use tabs properly. 
 
If you use the built-in tabs or use the space bar to simulate right-aligned tabs and 
therefore end up tabbing once on some lines, more on others you get something that looks 
like this. 
 

Figure 1:  How not to use tabs Multiple tabs between the text blocks, spaces have been used to 
simulate right-aligned tabs – this list will go all over the place if the page margins or font are ever 
changed, or if the list is ever pasted into another document 

 
Figure 2:  These tabs have been set properly A left indent and a decimal tabstop have been set 
on the ruler, there are no redundant tabs or spaces in the document  – this list will be very easy 
to maintain 
 
The golden rules when it comes to using tabs are: do set the tab positions yourself, and 
don't press the tab key more than once between any two blocks of text: set a tab 
position instead. You can easily see whether a tabbed list has been created properly by 
clicking the Show/Hide ¶ button , so you can see where the tabs are. 
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Types of tabs 
The Tabs dialog (accessed via Format | Tabs in Word 2003 and earlier) lists five kinds of 
tab stops, as follows: 
 
Left. This is the type you are probably most familiar with, the one you get by default 
when you press the Tab key. Text is left-aligned at the tab stop position. Center. When 
you tab to a Center tab stop, the text you type is centered at the tab stop position. 
 
Right. Text is right-aligned at the tab stop position. 
 
Decimal. This is a variant of the right-aligned tab stop. Text is aligned on the first non-
numeric character (apart from the thousands separator) following a series of numbers.  
 

Columns  
When you open a new blank document in Word, you begin typing at the left side of the 
screen/page and continue typing to the right margin, where Word wraps your text back to 
the left so you can start again. All your lines of text are full width. But sometimes you 
need to divide your text into two or more columns. 
 
Types of columns (tables, snaking columns, or ??) 
Word gives you several different ways of lining up columns of text. Which one you use 
depends on what you want the text to do. 
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Tabs in Columns 
If you want to enter text in one column, then text in another column on the same line, 
then more text in the first column (but on the next line), and so on, and if each of the 
entries will fit on one line, you may be able to align the columns using tabs. What you're 
doing here is creating a “tabbed table”: 
 
Tables 
If you want to be able to enter some text in one column, then text in another column 
aligned with it, then text in the first column again, then the second (and possibly a third, 
fourth, or more), and if the text in each column must be able to wrap to the next line, then 
what you want is a table. A table allows you to align text vertically as well as 
horizontally. Whenever you need to “synch” the columns, you begin a new row. 
 
Table columns are especially good for things like opera scores, where you need the text 
in the original score and the translation to line up with each other vertically. 
Text box columns 
 
 

Table Titles can go across many rows 
Junior’s Farm 

Dates - 2009 Asparagus Apples Avocados

June 141 203 75
July 133 222 66
August 88 288 45
September 23 256 0
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Linked Text boxes: 

 
 
It is possible to get text to flow from one Text Box to another. To do this, click on the 
first Text Box, then click on the Link button on the Text Box toolbar that will now be 
visible, and click on the second textbox. 
 

Text Box 1: 
In Greek and Roman tradition, 
this constellation represents the 
Scorpion whose sting caused the 

death of Orion; another legend it 
appears as the monster which  
frightened the horses of Phaeton 
when that bold youth attempted 
to drive the Chariot of the Sun. 



Word Class #2 EU 04/01/12 Page 13  

  

Snaking columns 
If you want the text to fill the first column and then snake into the next and fill it, 
continuing from Column A to Column B, then Column A on the next page, then you want 
newspaper-style columns. 
 

Treasure Island by Robert Louis 
Stevenson 

The Old Sea-dog at the 
Admiral Benbow 
 

SQUIRE TRELAWNEY, Dr. 
Livesey, and the rest of these 
gentlemen having asked me to write 
down the whole particulars about 
Treasure Island, from the beginning to 
the end, keeping nothing back but the 
bearings of the island, and that only 
because there is still treasure not yet 
lifted, I take up my pen in the year of 
grace 17__ and go back to the time 
when my father kept the Admiral 
Benbow inn and the brown old seaman 
with the sabre cut first took up his 
lodging under our roof.   

 
I remember him as if it were 

yesterday, as he came plodding to the 
inn door, his sea-chest following 
behind him in a hand-barrow—a tall, 
strong, heavy, nut-brown man, his 
tarry pigtail falling over the shoulder of 
his soiled blue coat, his hands ragged 
and scarred, with black, broken nails, 
and the sabre cut across one cheek, a 
dirty, livid white. I remember him 
looking round the cover and whistling 
to himself as he did so, and then 
breaking out in that old sea-song that 
he sang so often afterwards: 

 
"Fifteen men on the dead man's 

chest— Yo-ho-ho, and a bottle of rum!" 

 
 
 
Column Formatting 
If you are working in Page Layout (Print Layout) view and have text boundaries 
displayed, you will see that the text area has been divided into Column Margin Guides 
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To change column values, you may add tabs or grab margins one at a time or open the 
Columns dialog. Format menu: 

 
Type in the first column. The text will flow into the second column. If you're editing text 
near the top or bottom of a column, the constant text re-flow may be distracting. Use 
Normal View to stop seeing multi-columns.  They are still there Page Layout View. 
 
Headings spanning columns 
If you want a heading to span all of your columns, you need only leave it in the single-
column section before your multicolumn section. This is easily done by selecting the 
heading paragraph, clicking on the Columns button on the Standard toolbar or Page 
Layout tab, and selecting 1 column; Word will then create the necessary section breaks 
for you. 
 

Sections 
Sections are primarily to allow you to treat different parts of the Document in different 
formats.  
 
Columns on / Section break / Columns off 
Preface / Section Break / Chapter 
Pages are in Portrait / Section Break / Pages are Landscape 
 
The Columns function automatically adds section breaks, as needed.  You should avoid 
using sections otherwise, if possible.  They can be buggy. 
 
Creating Section Breaks in Word  
Page #1 in landscape with the rest appearing in portrait mode? Or perhaps you just want 
to modify the header \ footer for a few pages? Changes like these can only be 
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accomplished by dividing your document into sections. You can change the following 
section formats: margins, paper size or orientation, paper source for a printer, page 
borders, vertical alignment, headers and footers, columns, page numbering, line 
numbering, and footnotes and endnotes. 
 
Keep in mind that a section break controls the section formatting of the text that precedes 
it. For example, if you delete a section break, the preceding text becomes part of the 
following section and assumes its section formatting.  
 
Note that the last paragraph mark (¶) in the document controls the section formatting of 
the last section in the document. 
 
Section Break to Control Headers and Footers 
 
For a detailed guide on making section breaks check out this page: 
 
http://www.uwgb.edu/compserv/ehelp/word/section_breaks2.htm 
 

Headers and footers 
Word 2007 makes it easier to add a simple header, with fewer mouse clicks than previous 
versions. For example: 
1. In the ribbon, click the Insert tab. 
2. Click Header under the Header & Footer Group. 
3. Click Edit Header. 
 
In the blank header area, you can add details and page numbers.  
1. Press [Ctrl]R. 
2. Type your name and press [Enter]. 
3. Type Page. 
4. Click the Insert tab. 
5. Click Page Number in the Header & Footer Group. 
6. Click Current Position. 
7. Click Plain Number. 
8. Click the Close Header button. 
 
You can go back at any time and edit the header by simply double-clicking the header 
text on any page. When you finish, double-click outside the header area to continue 
editing the document.  
 
Same as Previous 
 
Header and Footers are by default set to “Same as Previous”. You may use the 
Header/Footer toolbar. 
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5) Setup styles which allows you to change each style all  at 

once 

Heading Style adjustment 
 
How to put a page break in front of each Heading 1 paragraph 
 
Change the Heading 1 style so that it includes the “Page Break Before” attribute. This 
will force each new Heading 1 paragraph to start on a new page. 
 
1. Choose Style on the Format menu. 
2. Select Heading 1 and click Modify. 
3. Pull down the Format list and select Paragraph. 
4. On the Indents and Spacing tab set the Spacing Before to 0.  
5. On the Line & Page Breaks tab check Page Break Before.  
6. Click OK, OK, Close. 
 
Default Paragraph Font 
The Default Paragraph Font is the default font of a document or template used by the 
Normal style. You can change the default font of the Normal template (Normal.dot) or 
another template. 
 
When you start Word with a fresh document based on the default Normal template, the 
Default Paragraph Font character style will be displayed in the Style menu as the font of 
the default Normal style, which is 10-point Times New Roman in Word 97 and 12-point 
TNR in Word 2000, 2002, and 2003. This display never changes!  
 
In Word 2002 and 2003, the Style list and Styles and Formatting task pane do not list 
Default Paragraph Font by default. You may choose to add it to the styles displayed, no 
specific font is associated with it. 
 
Suppose you have changed the font formatting of part or all of a paragraph and want to 
return it to the default font formatting of the style. One way to do this is to select the text 
and press Ctrl+Spacebar. Another is to apply the Default Paragraph Font character style 
from the Style menu. In other words, applying this “style” is actually a way of removing 
direct formatting. 
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6) Advanced Formatting Texts and Paragraphs 

Formatting Text 
 
The formatting toolbar is the easiest way to change many attributes of text. If the toolbar 
as shown below isn't displayed on the screen, select View|Toolbars and choose 
Formatting. 
 

 
 
• Style Menu - Styles are explained in detail later in this tutorial. 
• Font Face - Click the arrowhead to the right of the font name box to view the list of 

fonts available. Scroll down to the font you want and select it by clicking on the name 
once with the mouse. A serif font (one with "feet" circled in the illustration below) is 
recommended for paragraphs of text that will be printed on paper as they are most 
readable. The following graphic demonstrates the difference between serif (Times 

New Roman on the left) and sans-serif ("no feet", Arial on the right) fonts. 
 
• Font Size - Click on the white part of the font size box to enter a value for the font 

size or click the arrowhead to the right of the box to view a list of font sizes available. 
Select a size by clicking on it once. A font size of 10 or 12 is best for paragraphs of 
text. 

• Font Style - Use these buttons to bold, italicize, and underline text. 
• Alignment - Text can be aligned to the left, center, or right side of the page or it can 

be justified across the page. 
• Numbered and Bulleted Lists - Lists are explained in detail later in this tutorial. 
• Increase/Decrease Indent - Change the indentation of a paragraph in relation to the 

side of the page. 
• Outside Border - Add a border around a text selection. 
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• Highlight Color - Use this option to change the color behind a text selection. The 
color shown on the button is the last color used. To select a different color, click the 
arrowhead next to the image on the button. 

• Text Color - This option changes the color of the text. The color shown on the button 
is the last color chosen. Click the arrowhead next to the button image to select another 
color. 

 
The Font dialog box allows you to choose from a larger selection of formatting options. 
Select Format|Font from the menu bar to access the box. 
 

 
 
Paragraph Attributes 
 
Format a paragraph by placing the cursor within the paragraph and selecting Format | 
Paragraph from the menu bar. 
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Moving (Cutting) Text  
 
Highlight the text that will be moved and select Edit|Cut from the menu bar, click the Cut 
button on the standard tool bar, or press CTRL+X at once. This will move the text to a 
clipboard. 
 
To move a small amount of text a short distance, the drag-and-drop method may be 
quicker. Highlight the text you want to move, click the selection with the mouse, drag the 
selection to the new location, and release the mouse button. 
 
Copying Text  
 
To copy text, choose Edit|Copy, click the Copy button on the standard toolbar, or press 
CTRL+C to copy the text to the clipboard. 
 
Paste Text  
 
To paste cut or copied text, move the cursor to the location you want to move the text to 
and select Edit|Paste from the menu bar, click the Paste button on the standard toolbar, or 
press CTRL+V. 
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The Clipboard 
 
The last 12 elements that were cut or copied are placed onto Word's clipboard. You can 
view the elements on the clipboard by selecting View|Toolbars|Clipboard from the menu 
bar. 
 

 
Place the mouse arrow over each element in the clipboard to view the contents of each 
item and click on an element to add its contents to the document. Click Paste All to add 
all of the items to the document at once. Click the Clear Clipboard button (the icon with 
an "X" over the clipboard image) to clear the contents of the clipboard. 
 
Columns  
 
To quickly place text in a column format, click the Columns button on the standard 
toolbar and select the number of columns by dragging the mouse over the diagram. 
 

 
 
For more column options, select Format | Columns from the menu bar. The Columns 
dialog box allows you to choose the properties of the columns. Select the number and 
width of the columns from the dialog box. 
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Drop Caps 
 
A drop cap is a large letter that begins a paragraph and drops through several lines of text 
as shown below. 
 

 
 
Add a drop cap to a paragraph by following these steps: 
 
1. Place the cursor within the paragraph whose first letter will be dropped. 
2. Select Format|Drop Cap from the menu bar. 
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3. The Drop Cap dialog box allows you to select the position of the drop cap, the font, 
the number of lines to drop, and the distance from the body text. 

4. Click OK when all selections have been made. 
5. To modify a drop cap, select Format|Drop Cap again to change the attributes, or click 

on the letter and use the handles to move and resize the letter. 
 
Bulleted and Numbered Lists 
 
1. Click the Bulleted List button or Numbered List button on the 

formatting toolbar. 
2. Type the first entry and press ENTER.  This will create a new bullet or number on the 

next line. If you want to start a new line without adding another bullet or number, 
hold down the SHIFT key while pressing ENTER. 

3. Continue to typing entries and press ENTER twice when you are finished typing to 
end the list. 

 
Use the Increase Indent and Decrease Indent buttons on the formatting 
toolbar to create lists of multiple levels. 
 
NOTE: You can also type the text first, highlight the section, and press the Bulleted List 
or Numbered List buttons to add the bullets or numbers. 
 
Nested Lists 
 
To create a nested list, such as a numbered list inside of a bulleted list, follow these steps: 
 
1. Type the list and increase the indentation of the items that will make up the nested list 

by clicking the Increase Indent button for each item. 

 
2. Highlight the items and click the Numbered List button on the formatting toolbar. 
 
Formatting Lists 
 
The bullet image and numbering format can be changed by using the Bullets and 
Numbering dialog box. 
 
1. Highlight the entire list to change all the bullets or numbers, or Place the cursor on 

one line within the list to change a single bullet. 
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2. Access the dialog box by selecting Format|Bullets and Numbering from the menu bar 
or by right-clicking within the list and selecting Bullets and Numbering from the 
shortcut menu. 

3. Select the list style from one of the seven choices given, or click the Picture... button 
to choose a different icon.  

4. Click the Numbered tab to choose a numbered list style. 
5. Click OK when finished. 
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7) Spell check 

Check spelling and grammar automatically as you type 
 
Make sure automatic spelling and grammar checking are turned on. 
 
1. On the Tools menu, click Options, and then click the Spelling & Grammar tab. 
2. Select the Check spelling as you type and Check grammar as you type check boxes. 
3. Type in the document. 
4. Right-click a word with a wavy red or green underline, and then select the command 

or the spelling alternative you want. 
 
* You can use AutoCorrect to automatically correct spelling as you type, without having 
to confirm each correction. For example, if you type definately and then type a space or 
other punctuation, AutoCorrect automatically replaces it with "definitely." 
 
* If Word finds a lowercase word, for example "london," that is listed in the main 
dictionary only with a different capitalization ("London"), the capitalization may be 
flagged or corrected automatically as you type. You can specify that Word not flag this 
capitalization by adding the lowercase form to a custom dictionary. 
 
Check spelling and grammar all at once 
 
This method is useful if you want to postpone proofing a document until after you finish 
editing it. You can check for possible spelling and grammatical problems, and then 
confirm each correction. 
 
By default, Word checks both spelling and grammar. If you want to check spelling only, 
click Options on the Tools menu, click the Spelling & Grammar tab, clear the Check 
grammar with spelling check box, and then click OK. 
 
Do not spell check foreign quotes: 
 

In der siebten Folge unserer Aktion "Deutschland lernt kochen" zeigen 
Ihnen Food-Redakteur Bert Gamerschlag und seine Schülerin Audrey 
Pohl-Grosser per Video, wie Sie saftige Steaks braten können. 

 
1) Highlight the text, which you would like to omit from a spell check. 

2) Click the Tools menu, point to “Language”, and select “Set Language” 

3) Check the "Do not check spelling or grammar" check box. 

4) Click OK. 
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5) The text, which was just selected will now be exempt from a spell check in the 

current document. 
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8) Insert graphics, photos, tables,  columns 

The Draw layer 
 
Word's Draw layer is a space where you may put floating graphics or photos. Any text in 
the Draw layer is immune to many of Word's standard features such as Caption 
numbering, auto generated tables of contents, tables of figures etc. 
 
Examples are: photos, graphics, logos.  You may overlay draw layer over text or 
automatically make it wrap around it, left, center, right or custom justified. 
 
Examples Articles: 
Hear Music – The Right Way 
Enjoy an exceptionally natural sound experience with the high-quality Sennheiser CX550 
Style II. These sleek ear-canal phones produce a balanced sound with the highest possible 
sound resolution. The 
unique design of their 
housings allow for a 
personalised fit in the 
ear-canals and a high 
passive attenuation of 
ambient noise. Their 
short cable is perfect for 
use with a mobile phone 
or MP3 player with a 
remote-control and/or 
microphone.  
 
Dating in Los Angeles 
The multitude of dating opportunities available ranges from beach 
scenes in hundreds of movies and shows to paparazzi sparkling 
photos of the LA jet set, the bevy of opportunities for dream dates 
in the Los Angeles County area is famous. 
 
From light walks through the LA Zoo and Botanical Gardens to 
hiking in surrounding areas to days on the sandy shores, there is 
something for the active lover in each of you. Fusing the joy of 
time in the zoo with the tranquil pleasure of a garden paradise, the 
LA Zoo and Botanical Gardens is the perfect spot for you and your 
companion to enjoy the best of LA and some one-on-one 
conversation. 
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Frames 
 
Frames float, like Text Boxes, yet reside in the text layer and are accessible to Caption 
numbering, auto generated tables of contents, tables of figures etc. 
 
Captions 
By default Word puts the caption in a textbox, which means it won't update and won't 
appear in the Table of Figures.  To get round this you need to: 

Why does the document layout change when I open it on a different 
computer? 
 
Opening a document on another computer can cause the page breaks and graphic 
placement to be different. How can I make my document stay the way I want it?  Word 
will always try to format the document to match the printer selected. ways to minimize 
these changes. 
 
1. Don't use hard page breaks! Instead, use style and paragraph formatting to keep text 

together. Use “Keep with next,” “Keep lines together,” and “Page break before” 
formatting will keep important sections together.  

 
Get to these commands: Format menu (or shortcut menu) in Word 2003 and earlier; 
in Word 2007, use the “dialog launcher” arrow in the bottom right corner of the 
Paragraph group on the Home or Page Layout tab of the Ribbon. 

 
2. Use a Compatibility Option, “Use printer metrics to lay out document” 
 

Get to this command: In Word 2003 and earlier, find this check box at Tools | 
Options | Compatibility. In Word 2007, go to Office Button | Word Options | 
Advanced, scroll to the very bottom, and click on the + beside “Layout Options.” 

 
3. Select the printer on which you will ultimately be printing the document (even if it is 

not connected to the printer where you're editing). 
  
Use a PDF creator to lock in your document to exactly the format you want.. For Word 
2007 users, you can download the free Save as PDF add-in from Microsoft.  Adobe PDF 
creation software online has various levels of service, some are free.  Also Foxit, 
CutePDF and Primo PDF are free downloads. 
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9) Track changes in the document – omitted and cross out 

text 

 
Changes with revision marks 
 
Review tracked changes in two ways: by using the Reviewing toolbar or the Accept or 
Reject Changes dialog box. To review changes by using the toolbar, first make sure 
changes are highlighted on the screen. If the ScreenTips option is turned on, you can see 
who made each change by resting the pointer over the highlighted revision. 
 
If revision marks do not appear in the document, point to Track Changes on the Tools 
menu, and then click Highlight Changes. Select the Highlight changes on screen check 
box. 
 
If the reviewer information doesn't appear above the change when you rest the pointer 
over it, click Options on the Tools menu, click the View tab, and then select the 
ScreenTips check box. 
 
To Do This 
Review one change at a time Click Next Change or Previous Change on 

the Reviewing toolbar 
Accept the change Click Accept Change 
Reject the change Click Reject Change 
Accept or reject all changes in one pass On the Tools menu, point to Track 

Changes, click Accept or Reject Changes, 
and then click Accept All or Reject All. If 
you change your mind, you can click Undo.

See how the document would look if you 
accepted all changes 

On the Tools menu, point to Track 
Changes, click Accept or Reject Changes, 
and then click Changes, without 
highlighting. 

Display the original, unchanged document 
so you can see how the document would 
look if you rejected all changes 

On the Tools menu, point to Track 
Changes, click Accept or Reject Changes, 
and then click Original. However, if the 
document contains formatting changes, 
Word displays the changed formatting, not 
the original formatting. 

 
Strikethrough and other font features 
Apply strikethrough formatting to text or numbers 
 
1 Select the text that you want to format as strikethrough. 
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2 On the Format menu, click Font, and then click the Font tab. 
3 Select the Strikethrough check box. 
 
Examples: 
 
Strikethrough text. 
Double Strikethrough 
Normal text, Superscript 

Normal text, SubScript 

SShhaaddooww  tteexxtt  

EEEmmmbbbooosssssseeeddd   ttteeexxxttt    
EEEnnngggrrraaavvveeeddd   ttteeexxxttt  

SMALL CAPS 
ALL CAPS 
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10) Mail Merge – make hundreds of customized letters to 

an address list 

Mail merge 
Mail merge can be used for creating many documents at once that contain identical 
formatting, layout, text, graphics, etc., and where only certain portions of each document 
varies. Mail merge is also used for generating mailing labels, envelopes, address lists, 
personalized training handouts, etc 
 
Mail merge primarily consists of two files, the Main Document and the Data Source. The 
Main Document contains the information that will remain the same in each record, and 
the Data Source contains all the variable information, in the form of fields. This is the 
information that will change in the Main Document when the merge is completed. There 
are merge fields in the Main Document, which call to fields in the Data Source document. 
 
When the Main Document and Data Source are merged, Microsoft Word replaces each 
merge field in the Main Document with the data from the respective field contained in the 
Data Source. The end result is a third document, a combination of the Main Document 
and Data Source. Although you can also mail merge directly to the printer; (or fax or 
email) – you don't need to create a merged document on screen; and you can also 
“preview” the mail merge without actually merging (using the View merged data button). 
 
 

Steps 
 

Comments 
 

 
1. If you have an existing file you want to 
use as the merge document open it now. 
 

 

 
2. Start the Mail Merge Helper by going to 
Tools / Mail Merge. 
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3. Select the type of Main Document you 
wish to create. 
You will be asked whether you want to use 
the Active Window or a New Document. 
To use the document you opened in Step 1, 
select Active Window.  
 
If you select New Document, Word will 
create a blank document based on the 
Normal template. For most purposes it is 
much better to use a template specific to 
the task in hand rather than the Normal 
template; so Active Window is usually the 
better choice. 
 

 
Form Letters – A Section Break is placed 
between records in the completed merge. 
 
Mailing Labels – Records are merged to a 
table representing the label layout. If you 
use the wizard to create your labels, Word 
will insert a «Next Record» field at the 
start of every table cell except the first one. 
If creating your own customized label 
template, you will need to insert the «Next 
Record» fields yourself (you can use the 
“Insert Word Field” button to do this). 
 
Catalog – Records are merged 
continuously; use for mailing lists, 
telephone directories, etc. 
 
Envelopes – Similar to form letters except 
that an envelope paper definition is used. 
 

 
4 Click Get Data to select your Data 
Source. There are four methods you can 
use for your Data Source: 
a) Create Data Source 
 

 
This uses Word as the Data Source; setup 
your fields and type the data for the first 
time. The data is then stored in a Word 
table, which can easily be transferred to an 
Excel Data Source later if required. 
 
Note that you may find even a Word Data 
Source easier to set up without the wizard 
once you know what you're doing, as it's 
nothing more than a Word table with the 
items in the Heading Row of the table 
representing the mail merge fields – 
although you may well need to use Normal 
View to view all the data in the table if you 
don't want the columns to be incredibly 
narrow. Some experienced users prefer to 
use the wizard for this reason. 
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c) Use Address Book 
 

 
Use an Outlook or Outlook Express 
address book as the Data Source. (It can 
also link up to an Exchange *.pab and a 
Schedule+ Contacts list). 
 

 
d) Header Options 
 

 
If a Data Source from another program 
does not contain a Heading Row, or if field 
names in the Heading Row of your Data 
Source do not match the merge fields in 
your Main Document, you can use a 
separate Header Source and specify the 
field names. 
 
Field names must be listed in the same 
order as the corresponding information in 
the Data Source. 
Field names in the Header Source must 
match any merge fields you've inserted in 
the Main Document. 
 
However, where possible, build the 
Heading Row into your Mail Merge Data 
Source rather than having a separate 
Header Source – it simply makes life 
easier. 
 
Note that if your Data Source does contain 
a Header row, and if you nevertheless use a 
separate Header Source, the Header Row 
within the Data Source will be treated as a 
mail merge record – so be careful. 
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5. Select Edit Main Document. 
Add all text that you want to appear with 
every record; and insert the appropriate 
merge fields using the Insert Merge Field 
button on the Mail Merge Toolbar. 
 

 
You can use as few or as many of the data 
fields as you need to, and you can use them 
in any order. Also, any field can be used 
more than once. 
 
In a catalog merge, this text will appear 
with each record. If you want text to appear 
either before or after all records, it's best to 
add this to the completed merged 
document. 
 

 
6. You will want to add appropriate 
punctuation and spaces between the merge 
fields. 
 

 
Although blank paragraphs are suppressed 
automatically when you merge, spaces 
within a paragraph are not. 
 
Frequently (for instance, in an address) you 
will want to suppress spaces and 
punctuation following a field if the field is 
blank – for example, if you have “«Street, 
«City»”, then if there is no street in a given 
address, you won't want the comma and 
space to display. 
 
You can achieve this flexibility by using IF 
fields. See: Making your mail merge 
“intelligent” by using IF fields. 
 

 
7. As well as the obvious places, such as 
the address, you may also want to add mail 
merge fields at strategic points in the main 
body of the document – “«so-and-so» will 
be contacting you”, etc.. 
 

 
Frequently, you may want to make the 
results that are displayed dependant on a 
condition. For example, you may want to 
display “he” or “she”, depending on 
gender; or you might want to display 
either: “please let us know your start date”, 
or “you will commence employment on 01 
January 2001”, depending on whether the 
start date is known. 
 
Again, see: Making your mail merge 
“intelligent” by using IF fields for details 
of how to do this. 
 
 



Word Class #2 EU 04/01/12 Page 34  

  

 
8. You can preview your data prior to 
performing the merge by clicking the View 
Merged Data button on the mail merge 
toolbar. Doing this is far quicker than 
actually merging, if the Data Source is 
reasonably large. 
 
You can skip though the records by 
pressing the Next and Previous buttons. 
 
[You can also go to a specific record using 
the Find button (binoculars). This works 
fine under Word 2000 but can cause 
problems if you are using Word 97 – see: 
Why is mail merge unavailable after using 
the Find Record feature in Word 97?]. 
 
Having proof-read it in this way, you can 
merge straight to the printer if you want to, 
without having to create a merged 
document first. 
 

 
A couple of minor “gotchas” with using 
View Merged Data: 
  
Blank paragraphs are not suppressed until 
you do the merge. However, if you have 
the ShowAll button on, you will see a " 
symbol to indicate a paragraph that is going 
to be suppressed, instead of the usual ¶ 
symbol for a normal paragraph. 
 
Fields based on the total number of pages 
tend not to work as expected following a 
merge (e.g. Page X of Y), but this usually 
won't be apparent until you do a full merge. 
 

 
9. You may well need to filter the records, 
in order to merge only to a subset of your 
Data Source. 
 
You may also want to change the sort order 
for the merge without affecting the sort 
order of the Data Source. 
 
To do this, you can use Mail Merge Query 
Options 
 

 
For instance, you may be doing a follow-up 
mailshot to those people who didn't reply to 
the original mailshot. Or you may want to 
send a letter only to people whose birthday 
is this week. 
 
For details of how to do this, see: Turning 
Word into a pseudo-database by using Mail 
Merge Query Options. 

 
10. Prior to performing the merge, hold 
<Shift> and then select File/Save All. This 
will save the Mail Merge Main Document; 
and if the Data Source is a Word document, 
it will save that too. 

 
For additional formatting techniques, tips 
and tricks, and special merges such as 
setting up an Address Book, phone lists, 
merging graphics, suppressing duplicates, 
One-to-Many Relationships, see the Mail 
Merge home page on this site. 
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11.Perform the merge. Merge choices are: 
Merge to New Document 
Merge to Printer 
Merge to Email 
Merge to Electronic Fax 

 
For large mail merges, merging straight to 
the printer generally works better and is 
much faster than merging to a new 
document and printing that. 
 
If merging to Email or Electronic Fax, click 
the Setup button on the Merge dialog when 
you're ready to merge. Then select the Data 
field which contains the email address or 
fax number, type the subject line; and in 
the case of Email, choose whether or not 
you want the document to be sent as an 
attachment. Finally, you may also want to 
use Query Options to filter out any records 
that don't contain an email address/fax 
number. 
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11) Headers and Footers – Page numbering and section 

control 

Different header/footer on the second (and subsequent) page(s)? 
 
Change the header or footer at different places in the document by creating new sections. 
Header/footer instructions are stored in the last paragraph marker of the section. 
 
Each section can have up to three different headers and three different footers. Every 
document has at least one section but can have more. The number of header/footer sets 
for each section is controlled in  
 
1) File Page / Setup / Layout (tab) 

a) Different odd and even 

b) Different first page 

 
Different first page header/footer 
 
Set the header/footer for all pages and then set a different header/footer combination for 
the first page. 
  
4. View / Header and Footer 
5. A dashed border that says Header/Footer and. add text or codes from the header 

toolbar. 
6. Click the button Same as Previous. 
7. Create a Different (or No) Header / Footer for the First Page 
8. Save the file as a template if you wish to use it again. 
 

Tip:  This feature is often buggy on Word software. 
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12) User forms 

User Forms – How to use them 
 
One of the most powerful but also the most confusing aspects of Word is that there are so 
many different ways to accomplish the same task. For example, most commands may be 
accessed from menus, using toolbar buttons, or via keyboard shortcuts. “Drawing lines” 
in Word is one of the tasks that can be done in many ways, and the way you choose will 
depend partly on the end result needed and partly on personal preference. 
 
One important point to take into account is that in a business environment, if you design a 
form to be printed, and if it's likely to have any shelf-life to speak of, then sooner or later 
your users are likely to want to fill it in on screen. Unless you design your form with this 
in mind, they will one day waste a great deal of time redesigning your form so they can 
do so; and what's worse, 100 different users will individually waste their time creating 
100 different versions of your form! (Conversely, a form which you design for filling in 
on screen will inevitably be printed and filled in by hand by someone, sooner or later, so 
your design should allow for this also.) 
 
In a business environment, therefore, regardless of the short-term requirement, it is 
usually best if you design all your forms so they can be both printed and filled in by hand, 
and filled in on screen. 
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Drawing Lines 

 
A paragraph border can be a line (select Format + Borders and Shading to apply a line 
below a paragraph). If the bordered paragraph is an “empty paragraph,” the result will be 
a blank line all the way across the page (the width can be adjusted by dragging the 
paragraph's left and/or right indent markers). Since a paragraph border can be formatted 
to have different weights (from 1/4 point to 6 points) and several different styles (even 
different colors), such “lines” can be very fancy indeed. This option can be used only 
when there will be no form text on the same line, as everything in the paragraph will be 
“underlined.” 

 
 

 
Figure 1:  Paragraph borders  
 
Similarly, individual table cells can have borders. If your form is set up in a table 
(possibly using form fields to be filled out on screen), you can have a bottom border on 
the cell where the answer will go. This is the technique used in many of the templates 
supplied with Word, such as the Invoice and Purchase Order, which may usefully be 
studied to learn more about this approach.  
 
Using table cell borders is almost always the best method for any forms that may – ever – 
be filled in on screen.  
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You frequently need to separate adjacent lines from each other; and if using cell borders, 
the simplest way to achieve this is to create “dummy” cells with no borders, as shown in 
Figures 2 and 3. 
 
One common error form designers make is to create a single table for the entire form. In 
general, forms look and work much better if you create several smaller tables, separated 
by headings (for which you should use Heading styles).  
 

Figure 2:  “Fill in the blanks” lines created using cell borders  
 

Name  Start Date  
Dept  Line Manager  

 
 

Figure 3:  With Table Gridlines visible, see how borderless cells were used to create the effect 
 
When you select Format + Borders & Shading, “Apply to table” will be selected; change 
it to “Paragraph”; set your bottom border as you want it, using the Preview pane, and then 
click the “Options” button, and under “Distance from Text”, set the “Bottom” 
measurement to 2 or 3 points (otherwise your line will overlap with the descenders in the 
text). If you do use paragraph borders, it's best you do it using styles; get one border 
right, highlight the paragraph, type a stylename in the styles box on the Formatting 
Toolbar, and press Return, to create (or redefine) a style “by example”. You can then 
apply the same style elsewhere. 
 
Using paragraph borders would also allow you to dispense with the empty row at the 
bottom, used in Figure 3 – you could give the paragraphs in the final row a Space After 
setting sufficient to push the bottom border of the table down far enough not to look 
cluttered. The disadvantage of this method is that it could cause you problems if you add 
more rows later; you would have to remember to remove the increased Space After 
setting from any rows that were once the bottom row but no longer are – so both methods 
have pros and cons. 
 

Figure 4 shows a similar table to Figure 3, but this time using paragraph borders to create the 
text lines: 
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You can draw a line using the Line tool on the Drawing toolbar. If you hold down the 
Shift key while you are drawing it, it will be constrained to the horizontal or vertical.  
 
However, drawing lines can be formatted even more flexibly than paragraph and table 
borders, since the line weight can be typed in (not just chosen from a list); and in the case 
of Word 97 there is a much greater range of colors (Word 2000 borders can be formatted 
in any color). The position of the line can be specified relative to the paragraph to which 
it is anchored; once you figure out the correct relation of your “fill-in-the-blanks” line to 
the answer you want to type into it, it's just a matter of formatting subsequent lines the 
same. (For example, for a line of 12-point text with 12 points of Space Before, a line 
position of 0.35" – 0.89cm – relative to the paragraph is just about right.)  
 
One of the most common ways of making a “fill-in-the-blanks” line in a form to be 
printed (but not suitable if it is to be filled out on screen) is to use a right tab with an 
underline leader (in the Format Tabs dialog, choose the fourth option under “Leader”). 
Since the leader character is the same underline that you can type from the keyboard 
(shifted hyphen), you can mix and match these leader tabs with short lines typed in 
directly. One disadvantage of this type of line is that, because it is created with fixed-
width characters, although the ending point will be precise (the point where the tab is 
set), the beginning point can be rather unpredictable. 
 

Figure 5:  A line created using a tab leader – note the positions of the tabs on the ruler 
 
A subtly different approach from the leader tab is an underlined tab character (that is, 
press the Tab key, select the tab character, and format it as underlined). The two features 
that make this different are that (a) the tab does not have to be a right tab – any kind will 
do – and (b) the underline is not the same weight as the underline character; it is the same 
weight as the underline of underlined text. The underlined tab is easier to align with text 
than the leader tab, and it can be used (with some care) in a form to be filled out on 
screen because the underline will match that of underlined text (although table cells are 
generally simpler for on screen forms). 
 
So, if a user enters underlined text, the result will be the appearance of text typed on the 
line. On the other hand, typed underlines will not match the underlined tab, though 
underlined spaces can be used instead (em spaces are good for covering space more 
efficiently). Note that underlined spaces can be used only if followed by text; underlines 
are not displayed on trailing spaces unless they are non-breaking spaces. Note, too that 
the end points of underlined tabs will not be uniform unless the beginning point is; if you 
need to have a number of lines beginning at different points and ending at the right 
margin, you will have to use a right tab with an underline leader. Experimentation will 
show which is the more appropriate tool for a given application. 
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The weight of both underline leader tabs and underlined tab characters can be adjusted 
somewhat by changing the font size (the line height can be set to an exact measurement 
to preserve the line spacing), but this will be a more trial-and-error process than 
specifying the line weight of a border or drawn line. 
 
In a complex printed form you may wish to use more than one of the above techniques, 
but if you keep them all in mind, you will be able to select the most appropriate for any 
given application. (In a complex form that may need to be filled in on screen, sticking to 
table borders keeps things simple). 
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13) Macros 

Any task you repeat often may be made into a Macro instead and run with a quick two 
key combination such as [Alt 2]. 
 
Macros are advanced features that can speed up editing or formatting you may perform 
often in a Word document. They record sequences of menu selections that you choose so 
that a series of actions can be completed in one step. 
 
Recording A Macro 
 
To record a macro, follow these steps: 
 
1) Click Tools|Macro|Record New Macro on the menu bar. 

 
2) Name the macro in the Macro name field. This name cannot contain spaces and or 

begin with a number. 
3) From the Store macro in drop-down box, select the document you would like the 

macro to be associated with or choose "All Documents" be able to use the macro in 
any document. 

4) Enter a description of the macro in the Description field. This is for your reference 
only so you remember what the macro does. 

5) Click OK to begin recording. 
6) Select options from the drop-down menus and Word will record the options you 

choose from the dialog boxes, such as changing the margins on the Page Setup 
window. Select only options that modify the document. Word will not record toggle 
actions such as View|Toolbars that have no effect on the document itself. 

7) The recording toolbar will allow you to stop, pause, and resume recording. 
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8) Click the Stop button the recording toolbar. The macro is now saved. 
 
Running A Macro 
 
To run an existing macro, follow these steps. 
 
1) Select Tools|Macro|Macros from the menu bar. 
2) From the Macros window, highlight the Macro name in the list and click Run. 

 
3) If the macro is long and you want to stop it while it is running, press BREAK (hold 

CTRL and press PAUSE). 
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14) Print envelopes 

Modifying the appearance of your envelopes 
 
There are two principal components to the addressing of an envelope – the address to 
which it is to be sent and the return address of the sender. The position and format of 
each of these components is dictated by the definition of the following two styles in 
Word: 
 

Envelope Address 
 
Envelope Return 

 
The Envelope Address style contains a frame, into which the address is entered. The 
position and size of the frame dictates where the text appears on the envelope when you 
select Tools + Envelopes and Labels + Add to Document.1 
 
If you click in the frame and select Format + Frame, you will see that the width and 
height of the frame are set to “Exact” values, by default and the position of the text is 
further (and confusingly) influenced by a gigantic (and pointless) left indent defined in 
the paragraph properties of the style. 
 
These features can lead to problems, especially with custom-sized envelopes or with 
addresses containing more information than can fit within the fixed size of the frame. 
You may even find that with some envelope sizes, the vertical position is such that your 
address is in the unprintable area for your printer! 
 
You can, however, modify them, either in the Envelope Address style itself or, if it's only 
a one-off change, you need for a specific envelope, in the frame properties of your 
address.  
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To make a one-off change for a specific envelope 
 
1. Click in the address, and the frame borders will become visible. 
2. Select your address, and either drag the indent to the left margin using the ruler, or 

select Format + Paragraph and set the Left Indent to 0. 
3. Change the font and point size, if you want to. 
4. Then click on the frame borders, and to alter the width and height, you can drag the 

edge handles; hover over an edge handle, and when the mouse cursor turns into a 
two-headed arrow, start dragging. While you are dragging it, the mouse cursor will 
turn into a cross: 

 
Figure 1 
 
To alter the position of the frame, hover over the frame border with your mouse until the 
mouse cursor turns into a four-headed arrow: 
 

Figure 2 
 
Then drag the frame to where you want it. 
 
Finally, select Format + Frame, set the height to “At least” instead of “Exactly”, and do 
any other fine-tuning you wish to do: 
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Figure 3 
 
Alternatively, you could select Format + Frame at the outset and type the measurements 
in, but it is easier to do it by dragging, using the dialog for any fine-tuning you may need. 
To change the style for all envelopes 
 
Get the frame, font and paragraph properties as you want them by following the above 
steps. 
 
If you are using Word 2002 (Office XP), make sure the box for “Prompt to update style” 
is checked under Tools + Options + Edit – unfortunately, it's switched off by default, and 
defining styles is far more difficult unless the option is switched on. 
 
Then select the address (make sure the paragraph mark is selected). Now click in the 
styles bar on the formatting toolbar, and press Return: a dialog will appear asking 
whether you want to “update the style to reflect recent changes”; click OK. The changes 
you made to the frame and indent will now be reflected in the style definition for that 
document. 
  
 

  
Figure 4 
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To make the updated style definition available to all new documents (or if the current 
document is attached to a template other than Normal.dot, then to all new documents 
based on that template), select Format + Style + Modify, and check the box that says 
“Add to template”. 
 
If you are using Word 2002, it's a little more complicated, because the FormatStyle 
command is not on the Format menu. Instead, in the Styles and Formatting task pane, 
hover the mouse over the box at the top that shows the style in use. A down arrow will 
appear. Click the arrow to drop down the menu and choose “Modify”. This takes you to 
the Modify Style dialog and you can now check the “Add to template” box.2 
 
Then hold the Shift key down and select File + Save All. 
 
Once you have created an envelope, one strategy worth considering is to save the layout 
as a template, as this can greatly simplify creating further envelopes of the same type. 
Incorporating special text (such as “Confidential”) or graphics (such as a logo) in the 
envelope. 
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15) Table of Contents & Index 

Generate an Index in Word? 
 
The Microsoft Word Help suggests that you can automatically generate an index.  Sorry, 
but you can't (the "result" looks like an index, but the reader can't use it).  You can 
automatically mark index entries: however, the amount of work required to edit the result 
into a useable index is usually double the effort required to manually mark the index 
entries one-by-one. 
 
Word will do two forms of index: The Concordance Index and the Mark-up Index. It will 
also do something half-way in-between, using its “Mark All” command. 
 
Shortcut command to make a markup tag is [Shift Alt X]. 
 
Mark-up Indexes 
A Mark-up index is quick, accurate, easy to understand, and easy to correct.  With a little 
care in the planning, it normally results in a very useable index. 
 
As the term implies, you produce a mark-up index by embedding mark-up “tags” in the 
Word document. Word automatically looks up the page numbers at Print time and 
generates and formats the index for you.  
 
Concordance Indexes 
 
To make a Concordance index you make up a table of all the terms you want Word to 
find in one column, and the index entry you want to see for each term in the other. For 
more information, see “Create a concordance file” in the Word help file.  
 
The concordance mechanism can often be used to good effect in Reference Books such as 
Programming Reference Manuals, where each command or function is referred to only in 
a small section of the text, then rarely mentioned anywhere else in the book. 
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16) Fix problem documents 

Unexpected auto generated problems 
 
If there is an error or Word does something you do not want, use Undo it with the Undo 
button or by pressing Ctrl+Z.. 
 
1) Word makes a line across the page and it is difficult to delete it. 
 
The AutoFormat-As-You-Type feature that seems to cause the most trouble is Borders 
(see “There is a line in my document that I can't delete because I can't select it. How did 
it get there, and what can I do about it?”), but “Automatic bulleted lists” and “Automatic 
numbered lists” are a close second, and users can also be annoyed by the AutoCorrect 
features dealing with capitalization. It's a good idea to look at all the tabs of the 
AutoCorrect Options dialog to familiarize yourself with what these options are and 
choose the ones you actually want. 
 
Access this dialog from the Tools menu in Word 2003 and earlier; in Word 2007, the 
path is Office Button | Word Options | Proofing | AutoCorrect Options. 
 
2) Styles change based on formatting changes 
 
Perhaps the most insidious, and the most damaging is “Define styles based on your 
formatting.” Unfortunately, far from encouraging users to use styles properly, it simply 
applies styles (almost always inappropriately). 
 
What this option really means is “Apply styles that resemble your formatting.” So if you 
have a one-line paragraph which you have, for perfectly good reasons of your own, 
formatted as bold, perhaps in a larger point size than your text paragraphs, Word will 
decide that you mean to make it a heading and will apply one of its built-in heading styles 
(even though that style may not be what you intended at all). This is the most frequent 
single reason for people's tables of contents or Document Map not working properly. So 
this check box is a good one to clear! 
 
In fact, it is a good idea to turn off most of the options on the “AutoFormat” and 
“AutoFormat As You Type” tabs of AutoCorrect Options. In particular, it is best to turn 
off all the options under “Apply as you type” and “Automatically as you type”; the 
“Replace as you type” options are generally benign, but you will want to pick and choose 
these, as well. 
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3) Formatting applied to one paragraph affects the entire document 
 
If you are a user of Word 2002 or above, you may have had this experience: you click in 
a single paragraph or select several paragraphs and apply italics, bullets, numbering, or 
some other type of direct formatting and the entire document (or at least more paragraphs 
than you had selected) becomes italic, bulleted, numbered, etc. If you press Ctrl+Z or 
click on the Undo button, the change is reversed for all but the originally selected text. 
What’s going on here? 
 
If you look at the Undo list before pressing the button (by clicking the arrow beside it), 
you’ll see that the last recorded action is “Update Style” Some styles in Word are set to 
update automatically. This means that if you change the formatting of one paragraph in 
the style, you change the style itself, and the change is applied to all other paragraphs in 
that style. This behavior is the default for TOC styles (the ones used for entries in a table 
of contents), and in that case it is very convenient because the TOC styles can be rather 
difficult to modify otherwise. 
 
Automatic updating can be helpful. For example, when you are creating a template and 
fine-tuning the styles, you may want them to update automatically so that you can 
immediately see the results of your experimentation with different formatting (once 
you’ve settled on the desired formatting for a style, you’ll disable automatic updating). 
And if you use appropriate styles for varying types of paragraphs, this behavior will not 
get out of hand. But if you use Normal style for most of your paragraphs and apply direct 
formatting to change the appearance of specific paragraphs, you absolutely don’t want 
Normal style behaving this way, yet many users of Word 2002 and above do experience 
this. 
 
It’s not entirely clear how the Normal style becomes set to “Automatically update,” but 
this seems to happen far more frequently in Word 2002 and above than in previous 
versions, and it seems likely that this problem, like many others in Word, is caused by a 
poorly written add-in. 
 
4) How to correct Normal style from taking over. 
 
As stated above, if you click Undo, “Update Style” will be undone, leaving the 
formatting applied to just the text you meant to format. But this does not solve the 
underlying problem. To do that, you need to modify the Normal style directly.  This may 
not be allowed in many computers if the IT support person has locked out changes to 
Normal.dot. 
 
In Word 2002 and 2003 
 
1. If it is not already displayed, display the Styles and Formatting task pane (using the 

toolbar button or Format | Styles and Formatting). 
2. Select the style you’re using (presumably Normal) in the task pane and click on the 

down arrow to display the menu. 
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3. Choose Modify. 
4. In the Modify Style dialog, clear the check box for “Automatically update.” 

 
5. Check the box for “Add to template.” 
6. Press OK to close the dialog. 
 
In previous versions 
 
1. Go to Format | Style and select the style that is misbehaving (it will already be 

selected if the insertion point is in a paragraph in that style). 
2. Press the Modify button. The display will be similar to the Modify Style dialog 

above. 
3. In the Modify Style dialog, clear the check box for “Automatically update.” 
4. Check the box for “Add to template.” 
5. Press OK, then Close to close the dialog. 
 
Existing documents 
 
Note that checking the “Add to template” box will ensure that new documents you create 
will not have the given style set to update automatically, but the style will not be changed 
in existing documents. You will have to repeat the steps above (except for “Add to 
template”) in existing documents that are affected. 
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In Word 2007 
 
Solving the problem is a bit more problematic in Word 2007 because the Modify Style 
dialog for the Normal style does not include the “Automatically update” check box. 
Consequently, if the Normal style acquires the “Automatically update” property, it can be 
reversed only with a macro, as follows: 
 
1. Press Alt+F11 to display the Visual Basic Editor. Press Ctrl+G to show the 

Immediate Window. Type: 
 

ActiveDocument.Styles(wdStyleNormal). AutomaticallyUpdate = False 
 
2. Press Enter, and save the document. 
 
Existing documents 
 
Note that checking the “Add to template” box will ensure that new documents you create 
will not have the given style set to update automatically, but the style will not be changed 
in existing documents. You will have to repeat the steps above (except for “Add to 
template”) in existing documents that are affected. 
 
The bottoms of my pages don't print 
 
The page number, footer, or page border doesn't print or prints only partially (or: one side 
of my landscape pages won't print) 
 
Frequently people have problems with material at the bottom of a page (the page number, 
for example, or the footer) not printing correctly. Often, the characters get cut in half so 
that only the top half of the line prints. The most common complaint is that the bottom of 
a page border doesn’t print. 
 
The most common cause of this problem is that the bottom margin, footer margin, or 
page border is outside the printable area of the page. All printers have an irreducible 
unprintable area necessitated by the mechanical requirements of paper handling. 
 
Your printer manual may specify the printer’s printable area, or this information may be 
included somewhere in the Properties dialog for the printer driver. The simplest way to 
determine the printable area for your selected printer, however, is as follows: 
 
1. Go to the Page Setup dialog and choose the Margins tab. 
 
Note: Access this dialog in any version of Word by double-clicking the ruler. 
Alternatively, use File | Page Setup in Word 2003 and earlier; in Word 2007, on the Page 
Layout tab, locate the Page Setup group and click the dialog launcher in the bottom right 
corner. On the Mac, you have to choose Microsoft Word from the Settings drop-down 
before you will see the Margins button. 
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2. Set Top, Bottom, Left, and Right margins to zero. Click OK. Word will present the 

following dialog box: 
 

 
3. Accept Word’s offer to fix the margins and note what margins it sets. You can then 

Cancel out of the Page Setup dialog without actually changing the margins, but this 
will let you know what restrictions you’re working under. 

 
Usually the unprintable area will be largest on the trailing edge, that is, the bottom of 
portrait pages or one side of landscape pages. Inkjet printers in general have a larger 
unprintable area at the bottom of the page than laser printers (up to 0.67" is not 
uncommon; the record is probably 1.01" in case of the HP 420). Even printers that can 
print “borderless” may be able to do so only on certain sizes of paper (with a special 
carrier) and/or will require a special setting in the printer Properties. 
 

Frequently encountered problems with fonts 
 
The first thing to establish is the number of fonts you have installed (including 
variations). The limit is around 700–1000, although I would recommend having no more 
than 250. 
 
 * The default printer has been set to something other than the printer you are actually 
using, or no default printer has been selected. Check that your default printer has not been 
set to “generic, text only”, as this will stop fonts from showing. See also Word shows 
only one or two fonts in its Font list. 
 * If your fonts suddenly stop displaying properly in Word, you are almost certainly very 
low on memory resources. If this happens, reboot immediately (and don't save, or you are 
likely to corrupt your document). 

How to recover a bad Master Document 
A master document has only two possible states: Corrupt, or just about to be corrupt. And 
that is why we say that the only possible fix to a master document is “don't use it!” 

User Templates, Workgroup Templates & Global Templates 
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Templates are a special type of Word document. They hold components for other 
documents, especially text, Autotext, Macros & Toolbars. They also hold style 
definitions. When you save a document as a template Word will put attach the three-letter 
DOS extension of ".dot" to the end of the name instead of ".doc" but it is not the 
extension that makes it a template and changing the name either way will not change a 
document into a template or a template into a document. 
 
Creating a document. 
 
When you select New under the File menu, you are shown templates from which you can 
choose. There are also Tabs of more available selections. If there isn't room for all of the 
tabs, there will be one that simply says "More" and gives you access to the others. When 
you pick a template and create a new document based on that template, the template 
remains "attached" to the document.  
 
All styles in the template are created in the document and will stay with the document 
even if the attachment is later broken. 
 
Autotext entries, Macros and Toolbars in the template are available to the document so 
long as the document remains attached to the template, but are not normally transferred 
into the document. (Documents cannot hold Autotext entries but can have macros and 
toolbars.) 
 
If you move the document to a different computer that doesn't have the template, the 
attachment will be broken. You can change the template attached to a document using 
Tools - Templates and Add-Ins... 
 
User Templates Folder 
 
User templates are stored in a folder (usually on the user's computer) and normally called 
"Templates." The default location of this folder differs among the various versions of 
Word. Both the location and the name can be changed by the user. If you ask Word to 
save a document as a template, this is the folder you will be taken to for that purpose. 
You can see (and change) the location by using: 
 
Tools - Options - File Locations (tab) 
 
You can save templates any place you want to, but if you want them to show up in the 
File - New dialog box they must be in either the User Templates Folder. 
 
Workgroup Templates Folder 
 
 There is no default name or location for the Workgroup Templates Folder. You may 
create a directory and call it "Shared Templates"  
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Global templates 
 
Global templates are one type of "Add-In" for Word. They are normally not "attached" to 
any document and normally do not contribute text or styles to any document. They are 
excellent vehicles for holding and sharing Autotext, Macros and Toolbars. You can make 
any template global with: 
 
Tools - Templates and Add-Ins - Add (button) 
 
A file open dialog box will open showing the User Templates folder's contents to choose 
from. You can, though, add a template that is located elsewhere. Since they don't 
contribute text and are not used to start new documents, global templates are probably 
best kept elsewhere (not in the Workgroup Templates folder). 
 
Normal.dot 
 
Normal.dot is a special global template created and used by Word and should be in the 
User Templates folder. Unlike other global templates, it should not be shared. Also unlike 
other global templates, it shares styles with all open documents. If Word is unable to find 
the Normal.dot file when started, it will create one, using its defaults. 
 
Word 97 stores the templates that come with it in these same folders. Word 2000 keeps 
them elsewhere. If you want your template to show up under the tab for “Letters & 
Faxes” you need to create a folder with that title in your user Templates folder. Just File - 
Save As and select template as your file type. Before you save the template, create a new 
folder “Letters & Faxes” and store it there. 
 
More on Styles 
 
 A very fine look at styles was just published by Microsoft in the Legal Users Guide to 
Microsoft Word. You can find this on-line at http://www.addbalance.com/usersguide.   
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